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An operating system is a large, complex collection of software that manages the 

computer.  All communication between the central processor and the keyboard, 

mouse, screen, computer disk and network is controlled by the operating system. It 

is the operating system that detects the click of a button or the movement of the 

mouse. Other programs cannot communicate with these peripheral devices directly. 

They have to ask the operating system to carry out these tasks.

The operating system on newer Mac computers is called macOS.  This is based on 

the much older Unix operating system, first developed in 1969 at Bell Labs in New 

Jersey. 

This document introduces you to the basics such as managing your files and 

shortcuts that can improve efficiency when using macOS. To start, these shortcuts 

may seem uncomfortable but it is worthwhile spending some time practising, as it will 

allow you to perform tasks faster. It covers:

• Useful Applications  (e.g. Free access to Office365)  Page 2

• Managing Applications (e.g. Split Screen and Virtual Desktops)      Page 6

• Managing your Files   (e.g. Organising files/folders and backups)   Page 10

• Using a Terminal (e.g. Text-based commands to create folders)      Page 15

Comments, corrections and suggestions to izzi.mear@eng.ox.ac.uk 

Icons throughout sourced from FlatIcon.com, made by Freepik, Eucalyp, smashicons, wanicon, icongeek26 and tHose icons. 
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Useful Applications 

Your operating system will come bundled with some applications. Departmental 

computers will already have all the software you need, however if you are working on 

a personal computer there may be some software you need to install. 

Office 365

Students and staff at the University can access Office 365, which contains many 

useful applications for University work. The University of Oxford Office 365 system 

includes a cloud based working environment (called Nexus365). Follow the 

instructions here to get started: https://help.it.ox.ac.uk/nexus365/getting-started

Here you will find :-

Outlook: The Microsoft email client to view your University emails. 

One Drive: A cloud based filing system. You can use this to backup 

your files and share files with other people.

Word: The Microsoft word processor. You can save files as a Word 

document(.docx) to One Drive or your own computer.

Excel: The Microsoft spreadsheet. You can save files as an Excel 

spreadsheet(.xlsx) to One Drive or your own computer.

One Note: A digital notebook, you can use this for taking notes.

Powerpoint: Used for creating presentations.

Each of these can be used online, in your browser. Some browsers work better than 

others so it may be worth having multiple installed (e.g. Chrome or Firefox as well as 

Safari). 
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You can only get full functionality by installing the software directly onto your 

machine, which we recommend. Once you have logged into Nexus365, you will see 

the Install Office button on the right.

Teams App

Another part of Nexus365 is the Application Teams. It is an online chat/conferencing 

tool. Teams lets you message, talk to and see other members of the University. It will 

be used for any online laboratories. There is a web based version, but it does not 

work in Safari. 

Installing the Teams App 

Go to the web site: https://products.office.com/en-gb/microsoft-teams/download-app 

And select Download for Desktop. The installation is very straightforward. You just 

keep pressing the button in the bottom right hand corner.

Logging into the Teams App

Once Teams has launched: 

Sign in using abc123@OX.AC.UK 

Replacing abc123 with your own Single Sign On (SSO) username.

Then log in using your Oxford University SSO and password. Sometimes it 

capitalizes the first letter of the SSO. If it does this, change it back to lower case.
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PDF Reader

You will likely need to read many PDFs. MacOS can open PDFs in Mac Previewer. 

This allows you to read PDFs as well as highlight and make notes. Other free 

options are available, e.g. Adobe Acrobat. Whichever you use make sure you can:

• Search within PDFs: You will often work with many documents, searching for 

key terms using the Search bar is much faster than scrolling.

• Viewing Headings for Navigation: You can save a lot of time by enabling 

the navigation pane to click through Headings

In Previewer, view headings by opening Table of Contents:

In Adobe, open Headings via the button circled in yellow:

Other Applications

Other applications are available to everyone at the University, for free/a discounted 

rate, through the Central IT: https://www.it.ox.ac.uk/get-software  They are not 

needed for the Engineering course, but Adobe Creative Cloud Subscription for 

Photoshop etc or Parallels to run Windows on your Mac may be of interest.

4

https://www.it.ox.ac.uk/get-software
https://get.adobe.com/uk/reader/
https://www.youtube.com/watch?v=vK1sWu2M9Lw


Creating Text Files

You will not always want files where the text is formatted. In some cases you will 

want something very simple: just words as a .txt file. This could because of:

• personal preference (some people prefer the minimalist environment) 

• the wider range of compatibility (all OS will be able to read a .txt even if Word 

is not installed). 

Example

Follow these instructions to make a .txt file and see what you think:

• Click on the Launchpad to see the apps on you Mac.

• Click on Others.  

• Open TextEdit

This opens the Apple Text Editor.  This works with two different types of files. 

The Format menu allows you to select : 

• Plain Text format just contains ASCII character codes.  

You can't change the font.  These save to .txt files.

• Rich Text format contains extra formatting codes for changing the font and 

size of the text and other formatting commands.  These save to .rtf files.

Try the following :-

Select New Document

In the Format menu select Make Plain Text 

Enter the following text into the document :-

This is an example text file.

Save as ReadMe.txt. You can move this file later.

Security

Keeping your computer, files and identity safe is hugely important. Sophos Anti-Virus 

is available for free from the Central IT pages. You should also consider creating 

strong passwords and using a password manager. Many comprehensive guides can 

be found online, for example here.
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Managing Applications

Often you will need to work with multiple applications (apps) open. For example, if 

you are coding you may need a PDF of instructions open as well as MATLAB. Or if 

you are writing a report you may need an internet browser and a Word document. 

This section introduces you to different ways to work with multiple apps. It 

covers Split screen, Mission Control and Virtual Desktops. These are shortcuts that 

can improve efficiency moving between different applications. To start, these 

shortcuts may seem uncomfortable but it is worthwhile spending some time 

practising, as it will allow you to perform tasks faster. 

Minimising, Closing and Quitting

To get the best from your computer, it is important to only have the applications open 

that you need for your current task. Having too many applications open at once will 

cause your machine to be slow. You might think you are quitting applications by 

minimising and closing:

• You can minimise an application,  by pressing the yellow minimise button  

in the top-left corner of the window. 

• You can close windows of an application, by pressing the red close button 

in the top-left corner of the window. The shortcut Option-Command-W closes 

all windows open from a single application.

However, minimising or closing windows does not close or quit the app. 

The app will still be using memory, which will slow down your computer. Instead of 

you should quit applications by using the shortcut Command-Q, or click the app’s 

name in the menu bar, then choose Quit.

    Quit rather than close/minimise any applications you are not using.

This will free up RAM (a type of computer memory). 
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Split Screen View

To work with two applications at once, a simple option is to split the screen between 

two applications.  To do this:

• Open two applications on a Desktop.  

• Select and hold the green button in the top-left corner of one of the apps.

• The Desktop splits in two.  Drag the application to one half and release.  

• Then Click on the other application.

You can drag the divide between the two applications to the left and right.

As an example, the image below shows a Desktop that has been split between some 

notes on the left and MATLAB on the right. 

For more information, see the macOS User Guide.
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Maximising Applications

The approach of splitting the screen is not always the best option – particularly if you 

have a small monitor. Sometimes we need to work with an application which has 

been maximised to fill the screen. 

Maximise an application by clicking the green maximise button  in the top-left 

corner of an app window. 

You can also double-click an app’s title bar to maximise the window (as long as the 

option to do so is set to “zoom” in Dock & Menu Bar preferences).

When an application is maximised, you can view the banner and the menu bar by 

moving  the pointer to the very top of the screen.

Mission Control 

Mission Control offers a quick way to switch between multiple screens. There are 

many ways to start Mission Control:

● Press the Mission Control Key, as shown on the right.

● Hold down the control key and press the up arrow key, ▲.

● On a trackpad, swipe up with three fingers.  

Swipe down to leave.

If you have windows hidden behind other windows, Mission Control spaces out all 

the windows so that you can select which window you want in front.
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Virtual Desktops

Across the top of the screen, in Mission Control, is the Spaces Bar. 

 

Hit the plus sign, + on the far right of the Spaces Bar.

This creates a new Desktop.  You can have many different Desktops.  

Desktops are shown on the Spaces Bar (see Desktop 6,7,8 in the image above).

You can easily move between desktops. Once you have created a new Desktop, you 

don't have to use Mission Control to switch Desktops. It is much quicker to holding 

down the Control key and pressing the left arrow key,◄ or the right arrow key, ►.

So, for example, you can have some notes open in one Desktop and MATLAB open 

in another Desktop and use control ◄  and control ► to quickly switch from the 

notes to MATLAB.

Note: If you maximise an application, it automatically opens in a new space with the 

rest of the Desktops. You can move to and from the space in the same way that you 

move from Desktop to Desktop. 
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Managing your Files

Files and Folders 

A file is just a lot of ones and zeros stored in a permanent location on the 

computer.  Each file is used to store a particular type of object. 

It could contain a picture, a document, a program or many other types of object. 

Each file has a name, which may also include a suffix (ending • something) which 

helps to show what the file contains.  For example:

File name with suffix Type of File

Lecturenotes.pdf  A document

ReadMe.txt Plain Text

photo.jpg A Picture

MyScript.m A MATLAB Program

There are thousands of files on a typical computer. A file system is used to keep 

track of all the files. The file system is divided into folders.

A folder, also known as a directory, is a location where all the files related to 

a particular topic are stored. Folders help keep related files together, so they 

 do not get mixed up with other files on the system.  

Files and folders may seem basic, but keeping them organised can be a difficult 

habit to develop. It is always worth taking a few moments to correctly store your files.

 When you download a file, it is usually stored automatically in your 

Downloads folder. If you want to store it long term, move this file 

             so it is stored in a sensible folder elsewhere in your file system.

  As well as storing files on your computer locally, it is sensible to 

 store a copy of your files online too. e.g. using OneDrive
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A File System

The whole file system is organised in a hierarchy 

of folders within folders. The diagram on the right 

represents a very small portion of a Mac file 

system. Another name for a folder is a directory.

At the top of the file system is the folder known as 

the root directory. It is specified with a simple 

forward slash “/”. The root directory contains many 

other directories, more than the three shown here.  

The diagram looks a bit like a family tree. The 

words parent and child are used in computing to 

describe the relationship between directories. 

In the diagram:

• The directory P5comp is the parent of Sess1 and Sess2. 

• Sess1 and Sess2 are the children of P5comp. 

Home Directory

When using a computer, you don't want to mix up your files with those used by the 

operating system and other users. Therefore, each user on a system is allocated a 

Home Directory, where they can store their personal files.  On a Mac, these are all 

kept in the Users folder.  An example of creating folders is given on the next page. 

         Make sure that your Home Directory is always organised.

               This will make it easier to find files, and lead to efficient working.

If you already have some folders, you may want to move them around: This video 

shows you 10 different ways. It includes drag-and-drop, copy/paste, setting 

Favourites and custom Quick Actions. These are very useful shortcuts!
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Example: Creating Folders in your Home Folder

On the Dock along the bottom of the screen, Click on the Finder icon.

Click your Home indicated by a house, on the left hand sidebar.

Your contents will be shown on the right hand side.

If you do not see a house, from the Menu bar at the top of the screen:

• Select  Finder►Preferences. 

• Select the SideBar icon.

• Tick next to the house under Favourites.

Hold down the control key and click Home, on the right hand side.

There are many different ways of doing this. From the File menu, click 

on the gear wheel icon or a right click, if right clicking is enabled on 

your mouse. 

Select New Folder

A new folder will appear in your Home.  The name of the folder is 

highlighted so that you can type in the name of the folder.

To create the structure shown in the diagram on the previous page:

• Call the Folder Eng (stores files for your studies in Engineering Science)

• Double Click on the new folder, to view the contents.

• Inside the new folder, create another new folder called Year1.

• Inside Year1, create a folder called P5computing (storage for computing lab). 

Previewing Files

Aim to build a structure of folders, so you can easily find files. e.g. If you create files 

for the mechanics laboratory, you put them into a P5mechanics folder in Year1. The 

Finder has great preview capabilities too, to help navigating your files.
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File Paths

The file path is a way to describe the location of a file or folder, based on a fixed 

starting point. Every file/folder will have a unique absolute path. 

The Absolute Path of a file/folder (e.g. fileA) is the path you would have to 

take from the top of the system (root directory) to reach that file/folder.

Example:  Absolute Path of ReadMe.txt

Consider the file ReadMe.txt in the above diagram. Starting at the root directory, you 

would first have to go into the Users directory, then the users home directory (Jack), 

then Eng, Year1, P5comp until you arrive at ReadMe.txt. The Absolute path is 

/Users/Jack/Eng/Year1/P5comp/ReadMe.txt 

  It is recommended that you enable the Finder Path Bar. 

  With this, when you navigate your file system using Finder, 

  you will see the file paths of the folder you currently have open.

Backup using OneDrive

It is always a good idea to take a copy of your files, just in case anything happens to 

your computer.  As part of your University Single Sign On (SSO) account, you have 

access to One Drive. This is a file storage area linked to the Microsoft Office Suite 

available online. 

• Visit Office.com and click Sign In. 

• Use your SSO username with ending 

@ox.ac.uk 

• At the Shibboleth SSO Sign In page, 

use your SSO username and password. 
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Once you logged in, select OneDrive on your dashboard to open your file storage: 

• Use the Upload button to add files or folders to your storage area. You can 

also drag and drop. Try uploading a Folder.

• In OneDrive, Right Click any file and select Download to download a file.

  If you want to avoid manually uploading a back up to OneDrive,

you can set up a folder on your computer to sync using OneDrive.

Using Zip Folders

An easy way to transfer multiple files or folders between computers is to use a zip 

file. This stores all the data into a single file.  It also uses compression software to 

reduce the size of the data.

Zipping Items into a File

• Open the file or folder in Finder

• Control-click it or tap it using two fingers

• Select Compress from the menu.

You will now see a .zip file is created.

Extracting a Zip File

Double clicking on a zip file will extract the contents.
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Using a Terminal

So far we have shown the the easiest way of interacting with the operating system: 

using a Graphical User Interface or GUI. This is where you interact with the 

computer using a mouse pointer and click to interact with applications. 

Operating systems (OS) are designed like a nut:

• The main part of the OS is called the Kernel. This contains 

all the programs to manage the computer and hardware.

• Surrounding the kernel is the Shell. The shell contains the 

software that allows you to interact with the kernel.  

The GUI that you use to interact with your computer is a part of the Shell. However, 

this is not the only way of interacting with the Kernel.  There are also text based 

commands that allow you to control the OS without a mouse. This is known as using 

the Command Line. 

To use the command line, we use a Terminal environment. 

It is a simple window where we can type text. 

Why use the Terminal?

Imagine Errol the Engineer has just returned from a six-month survey of materials in 

different off-shore structures. The 1430 samples have been run through a testing 

machine, resulting in 1430 data files. The research group has worked with files from 

this machine before, and know before they can graph the results the files need to be 

put through a program called reformatData.sh. In the past, they only had 20 files, so 

this script was run 20 times by hand. If Errol has to run reformatData.sh by hand 

using a GUI, they will have to select and open a file 1430 times! If it takes even 30 

seconds to run each file, the whole process will take more than 12 hours. With the 

shell, Errol can instead assign the computer this mundane task! 

You are not expected to become a terminal expert this year, but it is important to 

know it exists and what it can do. If you start practicing now, it is a good skill to be 

able to put on your CV. The next few pages give a brief introduction of how to 

navigate files. For a full introduction to shell, see this self-paced online course. 
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Navigating Files using the Terminal

You cannot do anything in a terminal without knowing some commands. Different 

terminals will expect different commands. On a Mac, when you open the Terminal it 

expects bash (for Bourne Again Shell) commands. This section will introduce some 

key commands for looking at your files in the Terminal, like you would using Finder.

The basic tasks covered will be: Launching the Terminal, Checking the starting 

location, moving to a subfolder, listing the folders contents and then creating a folder.

1. Launch Terminal

• Click on Launchpad, then Others.       

• Open the Terminal app.

2. Check Starting Location

When using the terminal, you have a Current Working Directory. That is your 

current location within the file system. This is like when you open Finder and have a 

particular Folder open. You can also think of it as looking at one folder.

In the terminal, enter the command :

This Prints your Current Working Directory, your 

current location in the file system. To start with, 

the Current Working Directory is set to your 

Home directory.

Notice that when you press Enter, 

you will see a path returned. 

In our example it would be:

/Users/Jack
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   pwd
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3. List items in Current Folder

 To list the content of the Current Working Directory enter

You should see a list of all the files and folders in your Home directory. 

In our example, it would simply list one folder Eng.

4. Move into a Subfolder

To move around to look at other files/folders, use the command cd. It changes the 

current working directory. Here we move to subfolder called Eng then list contents.

In our example, we would see the current 

path printed (due to the pwd command):

/Users/Jack/Eng

Then a list of folders Year1 and Year2.

5. Create a new folder

To create a new folder, use the command 

mkdir. This stands for make directory. 

You should then see the new folder listed 

after the list command. 
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   ls This is a lower case L followed by a lower case s

   cd Eng 

   pwd

   ls
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   mkdir Year3

   ls



Relative Path

Earlier we introduced the absolute path (page 13).  The absolute path of a file can 

be very long. Typing in the whole of the absolute path every time you need to use a 

file, would get very tedious. A quicker way to specify the path from the Current 

Working Directory to the file or folder you are interested in.  This is called the 

relative path to a file. This describes a files location relative to the Current 

Working Directory. 

The Relative Path of a file/folder is the path you would have to take from 

the Current Working Directory to the original file/folder.  

Example: Relative Path moving Down

Considering the diagram on the previous page, if the Current Working Directory is 

/Users/jack/Eng/Year1/P5comp

• The Relative Path to ReadMe.txt is just ReadMe.txt

• The Relative Path to Prog1.m is Sess1/Prog1.m

A relative path does NOT start with a forward slash.

Example: Relative Path moving Up

You can also have a relative path that goes up the tree as well as down. Two full 

stops in a path indicates the parent directory from wherever you are in the path.  

If the Current Working Directory is /Users/Jack/Eng/Year1/P5comp/Sess2

• The Relative Path to Prog1.m is ../Sess1/Prog1.m

• The Relative Path to MyFrame.mat  is ../../P5mech/ MyFrame.mat

Relative paths take some getting used to, but can be a powerful tool when 

managing many files.
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Examples with Relative Path

We can use the ls command to list the contents of any folder on the file system.  

We can specify the folder we want by using the folder's absolute path :

or the relative path of the folder:

You can use the tilde ~ as a shorthand to indicate your Home directory:

Two full stops .. indicates the parent folder. The folder one level above  :

You can also use the two dots notation with the cd command:

The cd command on its own take you back to your home:

Now make another new directory inside P5Computing using the command mkdir.

There are many more commands that you can use. 

For a list of macOS commands, see http://ss64.com/osx

For a comprehensive introduction to shell, see this self-paced online course.
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  cd ~/Year1/P5computing   

  mkdir   NewFolder

   ls /

   ls /Applications

   ls /Users

   ls Year1 

   ls Year1/P5computing

   cd Year1/P5computing

   pwd

   cd ..  

   cd 

   pwd

   ls ~ 

   ls ~/Eng

   ls ..

   ls ../..
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